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CORE Installation Guide 

Getting Started 
Welcome to the CORE 5.1 Installation Guide. This guide is intended to assist you with the three steps 
required for getting started using the most robust systems engineering software tool available today:  
1) installing the software, 2) obtaining a license, and 3) starting the CORE 5.1 product. If you are a 
previous CORE user, this guide also provides information about upgrading from previous releases of 
CORE to 5.1. 

If you have any problems or questions regarding installation, licensing, or training for your CORE 5.1 
product(s), contact us: 

For installation or general product support 
support@vitechcorp.com 

For licensing questions  
licensing@vitechcorp.com 

For information on systems engineering and CORE training 
Visit our website at www.vitechcorp.com 
or contact your Account Executive 
+1 703.883.2270 
info@vitechcorp.com 
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Overview of the CORE Product Family 
CORE is the premier tool supporting model-based system engineering and product design including 
requirements analysis, behavioral analysis, architecture definition, verification, and design validation 
within an engineering or business process modeling project. 

CORE Workstation 
This single-user version of CORE includes a self-contained database management system that can travel 
with you on your portable computer. Databases or database changes can be exported facilitating design 
sharing and synchronization with a master database. CORE information and models can be shared with 
others through XML export, HTML views, graphic images, printed documents and diagrams. Behavior 
and architecture models can be viewed in as many layers of abstraction as necessary to understand how 
the model performs. CORE can be enhanced by COREsim to provide a desktop system engineering and 
simulation workbench. The simulator can be constrained to execute a single layer of a behavior model or 
it can navigate the entire logical decomposition to execute the integrated system model. 

CORE Enterprise 
This robust client-server version of CORE is designed to provide scalability for small or large project 
teams. CORE Enterprise utilizes a commercial object-oriented database management system to provide 
access to the project data repository from workstations on a local area network. 

CORE Enterprise Server supports transaction management between clients and the database 
management system. CORE Enterprise Server includes a dynamic update mechanism that synchronizes 
active clients, allowing changes published by one user to be automatically reflected in clients looking at 
the same data. 

CORE Enterprise Client is the end-user interface to CORE Enterprise Server, including the 
administrative functions for managing user accounts, assigning user permissions, and managing the 
licenses that govern tool utilization. It provides complete system engineering functionality using the same 
user interface as CORE Workstation. CORE Enterprise Clients may utilize COREsim to execute behavior 
models. 

COREsim 
COREsim adds discrete event simulation to CORE providing execution of the integrated architecture by 
dynamically interpreting the behavior model that resides in the system design repository. Discrete-event 
simulation logic supports timeline analysis, resource analysis, and consistency analysis. 

COREsim is a separately licensed option for CORE Workstation and CORE Enterprise clients. No 
additional installation is required. The corresponding licensing option will enable COREsim, if available.  

CORE2net Web Server 
A separately licensed component of the CORE Enterprise Server, CORE2net provides a web server 
interface to the CORE Enterprise system design repository. Authorized team members can access the 
repository by simply logging into the project website using a web browser such as Microsoft Internet 
Explorer® or Netscape Navigator®. CORE2net queries the current information contained in the CORE 
system definition repository allowing design changes and the current design state to be shared in real-
time. Designed for consumers of the system engineering information, CORE2net enables inter- and intra-
team collaboration at the Enterprise level with the ability to set up appropriate access permissions; 
engineers no longer need to be co-located; managers and other reviewers can access their data in 
familiar formats (tabular, graphical, and hyperlinked). 

CORE2net 5.1 can be installed on the same server as the CORE Enterprise Server or on a separate 
server. CORE2net licenses may be purchased from Vitech Corporation in 5-user packs. 
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CORE 5.1 Licensing Options 
Vitech offers four licensing options to provide flexibility in how CORE is deployed within your project team 
or organization. Please contact your Account Executive if you have questions about your specific 
configuration. 

Node License — the license file resides on your local hard drive. This option is best if you are working 
from a single machine. Your computer is identified by a unique ID which is then embedded in a license 
file from Vitech. The licensing runs in the background and is completely transparent to the user. The only 
drawback is that the license is not mobile. You can move the license from one machine or location to 
another but must pay a license transfer fee and submit a request to Vitech before a license can be 
transferred to the new machine. 

Floppy Key License — the license file resides on a floppy disk, and you simply insert the disk in the 
drive of the machine on which you wish to work. This option provides the ultimate flexibility as you can 
work from home, customer sites, or multiple machines in your office. The drawbacks are that 1) floppy 
disk drives are becoming less common and 2) you may observe a slight delay when the license is being 
checked (every 7-10 minutes on average) though most users never notice a delay. 

Enterprise License Mechanism — new in 5.0, the Enterprise license mechanism licenses a single 
Enterprise Server to support a specified number of clients. When Enterprise Clients connect to the server, 
the Enterprise Server checks to see if tokens (licenses) are available and permits the appropriate number 
of concurrent connections. The Enterprise Server is an excellent option for licensing a single Enterprise 
Server. If your site needs to share client licenses across multiple servers or support both Workstation and 
Enterprise licenses, you may wish to consider the network license manager instead. 

Network License Mechanism — the network license manager runs as a service on any Windows NT, 
2000, XP, or 2003 machine connected to the network. A registry file indicates how many and what type of 
licenses you have. Users log into CORE and CORE checks the registry file to see if there are tokens 
(licenses) available. The only requirement is that TCP/IP must be running as a network protocol. The 
network license manager is the most flexible licensing approach, allowing you to seamlessly share 
licenses across your network. However, it does involve a separate installation of the license manager 
software. 

Vitech offers two versions of the NLM: 

• NLM 5.0 uses the TCP protocol and is optimized for today’s network environment. New CORE 
installations should select NLM 5.0 for improved day-to-day operation and to take advantage of 
new logging capabilities. NLM 5.0 is recommended for sites running CORE 5.0 or later within a 
LAN environment. The initial NLM 5.0 release does not operate across firewalls (customers 
interested in this capability should install contact product support for details on the NLM release 
which will add this feature and install NLM 4.3 in the interim). NLM 5.0 is not compatible with 
CORE 4.0 Workstation and Enterprise Clients. 

• NLM 4.3 uses the UDP protocol. NLM 4.3 should only be used by those who plan to serve CORE 
4.0 and 5.1 licenses from a single NLM or those sites who wish to serve licenses across a 
firewall. 
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Step 1: Installing CORE 5.1 Products 
 

 

Important Instructions for Current CORE 5.0 Users: If you are upgrading from CORE 5.0, please refer to 
the Upgrading from CORE 5.0 to 5.1 section on page 28 for installation and licensing information. 

The following sections provide step-by-step instructions for installing the various CORE products. All 
CORE products should be installed by a user with appropriate installation permissions for the computer or 
server upon which the CORE product is to be installed. All installation routines update the Windows 
registry. The Enterprise installations also need to write to the system’s services file. If you have a question 
about the group policies defined in your environment, please contact your system administrator or IT 
support group. 

If you have any questions or need assistance at any point during this process, please contact Vitech 
Product Support at +1.703.883.2270 or support@vitechcorp.com. 

Following product installation, please refer to Step 2: Licensing CORE Products to obtain and install a 
license for products in the CORE 5.1 product family. 

Installing CORE Workstation 5.1 
1. If you have the CORE 5.1 CD, insert it in the drive and select “setup.exe” if the CD does not 

automatically launch. Click Install Products on the left side of the CD browser. Then click CORE 
Workstation on the list on the right to launch the CORE Workstation installation routine. If you do 
not have the CD, you can download the CORE Workstation installer from the Vitech website. 

2. In the InstallShield Wizard window, click Next. 

3. Review the end-user license agreement which governs the use of CORE. If you accept the terms 
of the license agreement, click the radio button next to “I accept” and then click Next to proceed 
with the installation. If you do not accept the terms of the license agreement, click Cancel to end 
the installation. 

4. Type your name in the User Name field. 

5. Type your organization’s name in the Organization field. 

6. In the Serial Number field, type your CORE serial number (found on the back of the CORE CD 
sleeve). If you do not have a serial number, you may leave this field blank. 

7. If CORE should be accessible to any user who logs in to this machine, click the radio button 
“Anyone who uses this computer”. If CORE should only be accessible to this user account, 
click “Only for me”. Then click Next. 

8. The installation wizard prompts you for the location to install CORE. By default, Windows 
applications are installed to the program files directory. You can either: 

 Confirm the location and click Next. 

OR 

 Click Change to select a different installation location; then click Next after selecting the 
alternate location. 

9. Select the setup type. A Complete installation (recommended) will install the CORE application 
and documentation files. A Custom installation will provide you the option to exclude the 
documentation. Once the setup type has been selected, click Next. 

10. CORE reports can be configured to use either US Letter or A4 paper. Select the appropriate 
paper size and click Next. 
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11. Small teams can configure CORE Workstation to share user configuration files on a network. This 
option provides portability of user definitions and settings between CORE Workstation 
installations within the network. For example, a user account created on one machine will be 
accessible on all machines. 

 If you will be using CORE Workstation in a team environment on the network, click Yes 
and specify the network location for sharing user definitions (ACF files). Then click Next. 

OR 

 If you will not be sharing user definitions with other machines on your network, click No. 
Then click Next. 

12. If this copy of CORE will be using the Network Licensing Manager (NLM) to obtain a license, you 
may specify the information for connecting to the license server. If you are unsure what license 
mechanism you are using, contact your local CORE administrator. 

 If this installation will use the NLM, click Yes. Enter the name (for example, AppServer) or 
IP address (for example, 192.168.135.210) of the machine running the NLM. Your local 
CORE administrator can provide this information. Then click Next. 

OR 

 If this installation will not use the NLM, click No. Then click Next. 

13. Click Install to begin the installation or click Back to change settings. 

14. After the installation routine completes, click Finish. 

 5



CORE Installation Guide 

Installing CORE Enterprise 5.1 Server 
Note: After you install the CORE Enterprise Server, you may have to restart your computer before you 
can use the product. 

1. If you have the CORE 5.1 CD, insert it in the drive and select “setup.exe” if the CD does not 
automatically launch. Click Install Products on the left side of the CD browser. Then click CORE 
Enterprise Server on the list on the right to launch the server installation routine. If you do not 
have the CD, you can download the CORE Enterprise Server installer from the Vitech website. 

2. In the InstallShield Wizard window, click Next. 

3. Review the end-user license agreement which governs the use of CORE.  

 If you accept the terms of the license agreement, click the radio button next to “Yes” and 
then proceed with the installation.  

OR 

 If you do not accept the terms of the license agreement, click No to end the installation. 

4. The installation wizard prompts you for the location to install the CORE Enterprise server 
application files. You can either: 

 Confirm the location and click Next. 

OR 

 Click Change to select a different installation location; then click Next after selecting the 
alternate location. 

5. The installation wizard prompts you for the location to install the CORE Enterprise repository. For 
best performance, choose a physical hard disk drive that Windows does not use for virtual 
memory. Typically, this means that the repository should not be installed on the C drive. You can 
either: 

 Confirm the location and click Next. 

OR 

 Click Change to select a different installation location; then click Next after selecting the 
alternate location. 

6. The installation wizard prompts you for the location for the CORE Enterprise transaction log files. 
For best performance, choose a physical hard disk drive that Windows does not use for virtual 
memory. For even better performance, choose a physical hard disk that is also separate from the 
CORE repository location specified in step 5. You can either: 

 Confirm the location and click Next. 

OR 

 Click Change to select a different location; then click Next after selecting the alternate 
location. 

7. The installation wizard prompts you for the location for the CORE Enterprise “hot” backups. The 
CORE repository will automatically be backed up to this location at whatever frequency you 
specify. The specified directory should have several GB free space to hold five repository 
backups (a backup of an empty repository is over 13 MB) You can either: 

 Confirm the location and click Next. 

OR 

 Click Change to select a different location; then click Next after selecting the alternate 
location. 
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8. Select which nights to schedule the “hot” backups and click Next. Vitech recommends that hot 
backups of the repository be scheduled nightly during the work week. 

9. Specify the TCP ports that the CORE Enterprise Server will use for communicating with the 
CORE Enterprise Clients and click Next. These port numbers must be unique (they cannot 
conflict with each other or with any other application running on your network). Under most 
circumstances, the default port numbers can be used. 

10. Specify the UDP ports that the CORE Enterprise Server will use to broadcast database updates 
to the CORE Enterprise Clients and click Next. These port numbers must be unique (they cannot 
conflict with each other or with any other application running on your network). Under most 
circumstances, the default port numbers can be used. 

11. Review the installation settings which have been specified. Click Next to begin the installation or 
click Back to change settings. 

12. After the installation routine completes, you may be prompted to restart your computer. Once the 
InstallShield wizard successfully installs CORE, click Finish. 

 If you wish to restart your computer now, click Yes then click Finish. 

OR 

 If you will restart your computer later, click No then click Finish. 

If the Microsoft Windows Firewall is being used, refer to Configuring Microsoft Windows Firewall for 
CORE for additional information. 
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Installing CORE Enterprise 5.1 Client 
1. If you have the CORE 5.1 CD, insert it in the drive and select “setup.exe” if the CD does not 

automatically launch. Click Install Products on the left side of the CD browser. Then click CORE 
Enterprise Client on the list on the right to launch the CORE Enterprise Client installation 
routine. If you do not have the CD, you can download the CORE Enterprise Client installer from 
the Vitech website. 

2. In the InstallShield Wizard window, click Next. 

3. Review the end-user license agreement which governs the use of CORE.  

 If you accept the terms of the license agreement, click the radio button next to “I accept” 
and then click Next to proceed with the installation. 

OR 

  If you do not accept the terms of the license agreement, click Cancel to end the 
installation. 

4. Type your name in the User Name field. 

5. Type your organization’s name in the Organization field. 

6. In the Serial Number field, type your CORE serial number (found on the back of the CORE CD 
sleeve). If you do not have a serial number, you may leave this field blank. 

7. If CORE should be accessible to any user who logs in to this machine, click the radio button 
“Anyone who uses this computer”. If CORE should only be accessible to this user account, 
click “Only for me”. Then click Next. 

8. The installation wizard prompts you for the location to install CORE. By default, Windows 
applications are installed to the program files directory. You can either: 

 Confirm the location and click Next. 

OR 

 Click Change to select a different installation location; then click Next after selecting the 
alternate location. 

9. Select the setup type. A Complete installation (recommended) will install the CORE application 
and documentation files. A Custom installation will provide you the option to exclude the 
documentation. Once the setup type has been selected, click Next. 

10. CORE reports can be configured to use either US Letter or A4 paper. Select the appropriate 
paper size and click Next. 

11. Enter the name (for example, AppServer) or IP address (for example, 192.168.135.210) of the 
machine running the CORE Enterprise Server. Your local CORE administrator can provide this 
information. 

12. Enter the TCP port number used for the NetLDI service. This should be the corresponding port 
number that was specified during the CORE Enterprise Server installation. Your local CORE 
administrator can provide this information (if in doubt, simply accept the default value). Then click 
Next. 
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13. If this copy of CORE will be using the Network Licensing Manager (NLM) to obtain a license, you 
may specify the information for connecting to the license server. If you are unsure what license 
mechanism you are using, contact your local CORE administrator. 

 If this installation will use the NLM, click Yes. Enter the name (for example, AppServer) or 
IP address (for example, 192.168.135.210) of the machine running the NLM. Your local 
CORE administrator can provide this information. Then click Next. 

OR 

 If this installation will not use the NLM, click No. Then click Next. 

14. Click Install to begin the installation or click Back to change settings. 

15. After the installation routine completes, click Finish. 
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Installing CORE2net Web Server 5.1 
Note: After you install the CORE2net Web Server, you may have to restart your computer before you can 
use the product. 

1. If you have the CORE 5.1 CD, insert it in the drive and select “setup.exe” if the CD does not 
automatically launch. Click Install Products on the left side of the CD browser. Then click 
CORE2net Web Server on the list on the right to launch the CORE2net Web Server installation 
routine. If you do not have the CD, you can download the CORE2net Web Server installer from 
the Vitech website. 

2. In the InstallShield Wizard window, click Next. 

3. Review the end-user license agreement which governs the use of CORE.  

 If you accept the terms of the license agreement, click the radio button next to “I accept” 
and then click Next to proceed with the installation. 

OR 

  If you do not accept the terms of the license agreement, click Cancel to end the 
installation. 

4. The installation wizard prompts you for the location to install the CORE2net web server. By 
default, Windows applications are installed to the program files directory. You can either: 

 Confirm the location and click Next. 

OR 

 Click Change to select a different installation location; then click Next after selecting the 
alternate location. 

5. Enter the name (for example, AppServer) or IP address (for example, 192.168.135.210) of the 
machine running the CORE Enterprise Server. Your local CORE administrator can provide this 
information. 

6. Enter the TCP port number used for the NetLDI service. This should be the corresponding port 
number that was specified during the CORE Enterprise Server installation. Your local CORE 
administrator can provide this information (if in doubt, simply accept the default value). Then click 
Next. 

7. Click Install to begin the installation or click Back to change settings. 

8. After the installation routine completes, click Finish. After the installation routine completes, you 
may be prompted to restart your computer.  

 If you wish to restart your computer now, click Yes. 

OR 

 If you will restart your computer later, click No. 

If the Microsoft Windows Firewall is being used, refer to Configuring Microsoft Windows Firewall for 
CORE for additional information. 
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Installing Network Licensing Manager 5.0 (NLM) 
Note: NLM 5.0 uses the TCP protocol and is optimized for today’s network environment. New CORE 
installations should select NLM 5.0 for improved day-to-day operation and to take advantage of new 
logging capabilities. However, NLM 5.0 is not compatible with CORE 4.0 Workstation and Enterprise 
Clients. Those organizations who wish to serve both CORE 4.0 and 5.1 licenses from a single NLM 
should install NLM version 4.3. 

1. If you have the CORE 5.1 CD, insert it in the drive and select “setup.exe” if the CD does not 
automatically launch. Click Install Products on the left side of the CD browser. Then click 
Network License Manager on the list on the right to launch the NLM installation routine. If you 
do not have the CD, you can download the NLM 5.0 installer from the Vitech website. 

2. In the InstallShield Wizard window, click Next. 

3. The installation wizard prompts you for the location to install the NLM. By default, Windows 
applications are installed to the program files directory. You can either: 

 Confirm the location and click Next. 

OR 

 Click Change to select a different installation location; then click Next after selecting the 
alternate location. 

4. Select the features to install and click Next. 

 The Program Files feature contains all program files required to run the NLM. This option 
is selected by default and cannot be unchecked. 

 The Firebird feature installs a public domain relational database management system 
which logs all license usage. Select this option if you wish to monitor the use and 
utilization level of CORE licenses. 

5. Review the installation settings which have been specified. Click Next to begin the installation or 
click Back to change settings. 

If the Microsoft Windows Firewall is being used, refer to Configuring Microsoft Windows Firewall for 
CORE for additional information. 
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Installing Network Licensing Manager 4.3 (NLM) 
Note: NLM 4.3 uses the UDP protocol. NLM 4.3 should only be used by those who plan to run CORE 4.0 
and 5.1 simultaneously for an extended period of time and want to serve all licenses from a single NLM. 
New CORE installations should select NLM 5.0 for improved day-to-day operation and to take advantage 
of new logging capabilities. 

1. If you have the CORE 5.1 CD, insert it in the drive and open the NLM 43 folder. Double-click 
“setup.exe”. If you do not have the CD, you can download the NLM 4.3 installer from the Vitech 
website. 

2. In the InstallShield Wizard window, click Next. 

3. The installation wizard prompts you for the location to install the NLM. By default, Windows 
applications are installed to the program files directory. You can either: 

 Confirm the location and click Next. 

OR 

 Click Change to select a different installation location; then click Next after selecting the 
alternate location. 

4. Click Install to begin the installation or click Back to change settings. 

5. After the installation routine completes, click Finish. 

If the Microsoft Windows Firewall is being used, refer to Configuring Microsoft Windows Firewall for 
CORE for additional information. 
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Configuring Microsoft Windows Firewall for CORE 
If the Microsoft Windows Firewall is being used within your enterprise, several files need to be added to 
the Firewall Exception list depending on your CORE configuration. The table below provides a list by 
CORE product of the files that need to be added and their location. 

CORE Product Directory Location File Names 

CORE Enterprise Server C:\CORE50Server\bin or 
D:\CORE50Server\bin by default 

gem50.exe 
netldid.exe 

CORE2net Web Server C:\Program Files\Vitech 
Corporation\CORE2net 50\bin 

httpvtca50.exe 
httpvtcc50.exe 
netldid.exe* 

NLM 4.3 C:\Program Files\Vitech 
Corporation\CORE NLM 43 by default 

nlmsvc43.exe 

NLM 5.0 C:\Program Files\Vitech 
Corporation\CORE NLM 50\bin by 
default 

nlm50b.exe 

* Only required if CORE2net is installed on a separate server from CORE Enterprise 5.0. 

To add these files to the Windows Firewall Exception List: 

1. Go to Start Menu > Control Panel > Windows Firewall. 

2. Select the Exceptions tab. 

3. Click Add Program to add the first executable to the exception list. 

4. Click Browse and select the folder specified in the table above for the file to be added 

5. Click on the corresponding file name 

6. Click Open then click OK. 

7. Repeat Steps 3 through 6 until all relevant files are added to the Exception List. 
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Step 2: Licensing CORE Products 
For specific information about the licensing types, refer to CORE 5.1 Licensing Options. If you have any 
questions or need assistance at any point throughout this process, please contact Vitech Product Support 
at +1 703.883.2270 or support@vitechcorp.com. 

General Instructions for Obtaining a License 
The three steps for generating a license request are the same whether you are licensing a single copy of 
CORE Workstation, an Enterprise product, or the Network License Manager: 

1. Generate a license request 

2. Email the license request file to Vitech 

3. Copy the license file received from Vitech to the appropriate directory on the computer or server 
hard drive 

The only differences are where you go to find the license request utility and the specific name/location of 
the license file provided by Vitech and the location where it is copied. The table below provides the 
specifics by license type/product. The general steps for obtaining a license are described in detail. 

License Type / Product License File Name Storage Location for License File 

Node License for CORE 
Workstation or CORE 
Enterprise Client 

CORELIC2.DAT CORE50Workstation main directory 
or CORE50EnterpriseClient main 
directory 

Floppy Key* CORELIC2.DAT 3½ inch floppy key disk 

Enterprise License Mechanism ENTLIC.DAT CORE50Server\data directory  

CORE2net Web Server CORELIC2.DAT CORE2net 50\bin directory 

NLM 4.3 REGISTRY.DBX NLM 4.3 main directory 

NLM 5.0 REGISTRY5.DBX NLM 5.0\bin directory 
* No user action is required for the floppy key. It comes pre-licensed from Vitech. 

COREsim does not require a separate license file. The primary license file indicates whether the 
COREsim option is available and COREsim is automatically enabled if this flag is present. 

If multiple products are being licensed for the same machine, only a single license request needs to be 
generated and sent to Vitech. Vitech can use this request to generate the license files required for each 
product. 
Important Instructions for Current Users: If you have an existing CORE license and are simply upgrading 
to CORE 5.1, do not run the License Request Utility. Generating a new license request will invalidate your 
existing license file and will disable CORE until the new license file is installed. Simply email a copy of your 
existing license file to licensing@vitechcorp.com. Vitech will upgrade this license file and return it to you via 
email. Then copy the upgraded license to the appropriate directory as shown in the previous table. If you 
have an existing CORE2net license or NLM registry running on the Enterprise Server, simply email a copy of 
your existing license file to licensing@vitechcorp.com and skip to step 3 on page 16. Vitech will upgrade this 
license file and return it to you via email. Generating a new license request will invalidate your existing 
license file and will disable CORE until the new license file is installed.
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Complete the following three steps to obtain a license for your CORE product(s): 

1. Generating a license request  

 From the Windows Start menu, select All Programs > “name of CORE Product being 
installed” > Utilities > License Request. 

 
 Select the Generate command from the File menu. 

 
 Enter your name or the name of the organization for which the license is being 

generated. 

 In the Serial Number field, type your CORE serial number (found on the back of the 
CORE CD sleeve). If you do not have a serial number; type 01-234-56-789 and click OK. 
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 Use File > Exit to save the generated license file as “OrganizationName – 
LicenseRequest.req” on the Desktop and then exit the License Request Editor. 

 
2. Submitting the license request 

 Once you have generated the license request file, email the file (OrganizationName – 
License Request.req) as an attachment to licensing@vitechcorp.com.  Vitech 
Corporation will validate your license status and return a corresponding license file via 
email. 

3. Installing the license 

 Save the file received as an attachment to your Desktop. 

 Copy the file to the appropriate directory on the workstation or server being licensed. 

Warning: For new installations, only one request should be generated per machine. This one request can 
be used to generate a license for one or more products running on that machine. If a second request is 
generated on the same machine, the previous license request is invalidated. For users who have 
previously licensed CORE, generating a second license request will invalidate all existing licenses. 
Holders of current CORE licenses should follow the instructions on page 14. 
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Using a Floppy Key License 
This license can be moved between machines to run and operate a copy of CORE Workstation or CORE 
Enterprise Client. By selecting a Floppy Key license, you have chosen to use the red 3½ inch floppy disk. 
The CORE software runs through a series of licensing checks to locate the license file in the 3½ drive.  

 

Warning: When using a floppy key license, the diskette cannot be removed from the floppy drive at 
any time during operation. If CORE performs a license check and does not find the floppy key, you 
may be forced to end your session. Before CORE terminates, you will be given the opportunity to 
export your data. 

To use a floppy key license: 

 Confirm your license selection with your Account Executive. 

 Vitech Corporation will send a primary and backup floppy key. The primary diskette is fully 
licensed. Vitech can activate the backup key diskette if the primary diskette fails. 

 Before launching CORE, simply insert the floppy disk into your disk drive. 

Important Instructions for Current Users: To upgrade your CORE 4.0 floppy key to CORE 5.1, 
please email the CORELIC2.DAT file from the primary key to licensing@vitechcorp.com. Vitech will 
upgrade this license file and return it to you via email. 
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Using the Enterprise License Mechanism 
By using the Enterprise license mechanism, you have chosen to license a single Enterprise Server to 
support a specified number of clients. Nothing needs to be restarted after installing the license file. It 
becomes effective immediately. However, clients that are already using another license will have to exit 
and launch again to obtain an Enterprise license. 

Using Network Licensing Manager 5.0 / Network Licensing Manager 4.3 
By using the Network Licensing Manager (NLM), you have chosen to set up a group environment to allow 
users to share CORE licenses across your network. 

Starting (or Restarting) the Network License Manager 

After installing REGISTRY5.DBX or REGISTRY.DBX license file as appropriate, the NLM must be 
restarted to read the new license. 

1. Ensure that no users are currently utilizing the NLM. 

2. From the Windows Control Panel menu, select Administrative Tools. Then open the Services 
control panel. 

3. For NLM 5.0, select CORE Network License Manager 5.0 and click Start the service (if the 
service is currently stopped) or Restart the service (if the service is currently running). 

4. For NLM 4.3, select Network License Manager 4.3.3 and click Start the service (if the service is 
currently stopped) or Restart the service (if the service is currently running) 

Licensing CORE2net Web Server 
The CORE2net Web Server is an add-on to CORE Enterprise Server. The CORE Enterprise Server must 
be installed and licensed before CORE2net is licensed. 

Starting (or Restarting) the CORE2net Web Server  

After installing the CORELIC2.DAT license file, the CORE2net web server must be restarted to read 
the new license. 

1. Using the CORE2net Monitor in the Administrative Tools view of the CORE Enterprise client, 
ensure that no users are currently logged in to CORE Enterprise. 

2. If CORE2net is currently running, select the Stop CORE2net Server command from the 
Administrative Tools > Admin menu in the CORE Enterprise client. 

3. Select the Start CORE2net Server command from the Administrative Tools > Admin menu in 
the CORE Enterprise client. 
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Step 3: Getting Started with Your CORE Software 

CORE Workstation 
The installation program creates a new program group entry on the start menu with the title "CORE 
Workstation 5.0". It contains an entry labeled "CORE Workstation 5.1 Image". To run CORE with the 
default image (COREIMAG.C50), simply click on this menu item. 

 

 

 

T
a
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Note: If using the NLM, you will be prompted to pick up a token before proceeding to the CORE
Workstation 5.1 Login window. 
Note: If the Microsoft Windows Firewall is being used and you are using the Network License 
Manager, a firewall window will appear when you start CORE Workstation for the first time. Windows
Firewall will ask you to choose to either Block or Unblock the “core50.exe” file. Select Unblock. The 
CORE Login window will then appear. 
he CORE Login window shown below will open. CORE Workstation is configured with one initial user 
ccount—the Administrator account. The user name and password are case sensitive. Log in as shown 
elow:  

User Name: Administrator 
Password: admin 
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After logging in, new user accounts can be created and passwords may be changed via the User/Group 
Tool accessible via the Administrative Tools link. At this point, the CORE software is installed and 
licensed. Now you’re ready to get started using CORE. The Additional Tips section provides information 
regarding how to learn more about how CORE supports model-based system engineering and 
architecture frameworks. 
Note: In CORE Workstation, if you change the Administrator password, be sure to save the image. 
For security reasons, unlike all other account passwords, the Administrator password is never loaded 
from the disk-resident access control files (ACFs) for use at login. Therefore, the only way to store a 
new password for the Administrator account is to save the image after changing the password. 
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CORE Enterprise 5.1 Client  
The installation program creates a new program group entry on the start menu with the title "CORE 
Enterprise 5.1 Client". It contains an entry labeled "CORE Enterprise 5.1 Client". To run CORE, simply 
click on this menu item. 

 Start > All Programs > CORE Enterprise 5.1 Client > CORE Enterprise 5.1 Client 

 

 

I
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Note: If the Microsoft Windows Firewall is being used, a firewall window will appear when you start
CORE Enterprise Client for the first time. Windows Firewall will ask you to choose to either Block or 
Unblock the “core50e.exe” file. Select Unblock. The CORE login window will then appear. 
f the Network License Manager is being used, you will be prompted to pick up a token before proceeding 
o the CORE Enterprise 5.1 Client Login window. If the Enterprise License Mechanism is being used, you 
ill see a similar prompt to pick up a token after logging in. 

 
he CORE Login window will now open. The designated CORE administrator can now log in to CORE 
sing the default account. The user name and password are case sensitive. 

User Name: Administrator 
Password: admin 
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After logging in, the administrator should change the Administrator password and then create accounts 
for each member of the project team. 

Users should contact their CORE enterprise administrator to obtain account information. 

CORE2net Web Server  
By default, the CORE2net Web Server is configured to start automatically when the Enterprise Server 
starts. To manually start/stop the web server or change its configuration, a CORE system administrator 
may log into CORE Enterprise and use the CORE2net Monitor in the Administrative Tools. 

To connect a web client to the CORE2net web server, simply direct the client to the web server name and 
CORE2net port (port 80 by default). For example, if the CORE2net Web Server is installed on a machine 
named “MyProject”, enter “\\MyProject” in your web browser. Users then log in using their CORE account 
name and password. 
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Additional Tips 
The sections below provide useful information to support your use of CORE. 

Check for Latest Service Packs 
Periodically Vitech Corporation provides Service Packs to upgrade the CORE product suite. Please check 
to ensure that you have the latest Service Pack at www.vitechcorp.com/updates.html. 

CORE Training 
Vitech offers ongoing training to help users learn more about using CORE in support of systems 
engineering and architecture frameworks including: 

Model-Based System Engineering with CORE—This class introduces Vitech’s proven system 
engineering process/methodology that can be applied to any project. This methodology assists with the 
organization of requirements, the identification and management of risks, and the establishment of real 
system boundaries on your development activity using CORE. The class makes use of scenarios/Use 
Cases that are then executed using COREsim, Vitech's discrete event simulator, to gain insight into 
performance issues that models alone cannot provide. 

Advanced CORE Techniques—This class is designed for users who want to be able to unleash the 
power of CORE by tailoring the schema, using advanced CORE features, and applying the COREscript 
language for document production, enhanced simulations, and data exchange. 

CORE On-line Help and Documentation 
The CORE user reference guide is accessible as an online reference available from within CORE 
Workstation or CORE Enterprise Client. To access context sensitive help from a specific window, simply 
click in the window and press the F1 function key. If you prefer to navigate by volume, flip through the 
index, or simply perform an electronic search, the online help will meet your needs. Also available from 
the CORE 5.1 program group entry on the Start menu are shortcuts to documentation including: 

 What’s New in CORE 5.0 & 5.1 
 CORE Architecture Definition Guide 
 CORE System Definition Guide 
 CORE Icon Reference Guide 
 COREscript Construct Reference  
 COREscript Expression Language Reference  
 CORE API Reference  

Adobe's Acrobat Reader is needed to view this documentation. You can download the latest version of 
Adobe Acrobat Reader free of charge at http://www.adobe.com. 

Sample Solutions 
The Samples directory within your CORE Workstation or Enterprise Client installation provides sample 
definitions of an Image Management System and a Fast Food Restaurant in 
ImageManagementSampleProblem.xml and FastFoodSampleSolution.xml, respectively. These files can 
be imported into CORE to view and manipulate. A requirements source document has been provided for 
each sample (i.e.,ImageManagementSampleProblem.doc / ImageManagementSampleProblem.txt and 
FastFoodSampleSolution.doc). These samples were developed using the CORE Release 5.0 base 
schema and, therefore, can be imported into a project created using either the 5.0 base schema or the 
DoDAF schema. 

The Samples directory also contains a DoDAF subdirectory, with a sample DoDAF model. The sample 
definition of the Tactical Image Management architecture is provided in the 
TacticalImageManagement.xml file. This sample was developed using the DoDAF schema and, 
therefore, can only be imported into a project created using the DoDAF schema. The readme file within 
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the subdirectory provides more information regarding the use of the sample with the DoDAF scripts 
provided with CORE 5.1. 

Using RDT Files from Previous Versions of CORE Workstation 
CORE 5.1 fully supports importing RDT files from CORE 2.x and later. There is an option in CORE 5.1 
that allows exporting the RDT file in 2.x, 3.x, and 4.x formats to enable interchange with previous versions 
of CORE. 

Working with Report Files from Previous Versions of CORE 
CORE 5.1 can read and execute report scripts created in previous versions of CORE. However, report 
scripts written or modified in CORE 5.1 using the base 5.0 schema cannot be used in version 4.0 or 
earlier. 

CORE Workstation Tips 

Maintaining an Empty Image  
A copy of the empty image file (COREIMAG.C50) should be maintained to allow each user to start with a 
new image. The installer will mark the empty COREIMAGE.C50 file as read-only. Therefore, the first 
attempt to save an image within CORE must be done via File>>Save Image As... to save the image 
under a new name or different location. 

Creating and Using Multiple Images in CORE Workstation 
You can store multiple images on your system (e.g., to keep a version history of your system design). You 
can create a new image by making a copy of an existing image (.C50 file) under a new name (keeping 
the .C50 extension) or, from within CORE, by using the File>>Save Image As... command. The 
File>>Save Image As... command will include an option to create a shortcut to the new image file in the 
CORE programs folder on the Windows Start menu. 

To start an image other than the default image, double-click on the .C50 file of your choice from within the 
Windows Explorer or a Windows directory window. For quicker access, you can create a shortcut for your 
image file on your desktop. 

Create Shortcut Option in CORE Workstation 
The "Create Shortcut" checkbox on the Confirm Save Image dialog, which appears during the Save 
Image As... sequence, can be used to create a shortcut to the new image file. If the option is checked, the 
shortcut will be created in the CORE Workstation 5.0 programs folder on the Windows Start menu. 

Disaster Prevention/Recovery 
In CORE Workstation, CORE images (.C50 files) store your CORE database and the state of the CORE 
application in a machine-readable binary format. Read this brief section to learn what you can do to avoid 
losing data and to recover from mishaps if they occur. 

1. When an error occurs, particularly when you are saving or launching an image, contact Vitech 
immediately. Do not attempt to save or launch the image a second time. If a non-fatal error 
occurs at any other time (when you are not launching or saving an image), the first command you 
should reach for is Export. 

2. In the Confirm Save Image dialog there are two checkboxes. We recommend that you keep both 
of these options enabled at all times. When you save your image, the Make Backup option copies 
the image as you last saved under the same name, but with a .BAK extension instead of the .C50 
extension. The Export Database option simultaneously exports your database to an XML or RDT 
file. Even if your database grows so large that exporting your database becomes cumbersome, 
we recommend that you still export your database on a regular basis. 

3. As you work in CORE, the changes you make are logged to a recovery file. This file has the same 
name as the image you loaded but with _RECOVER.LOG appended. You can turn this capability 
off in the CORE Preferences dialog, but we strongly recommend that you leave it active. In the 
event of a fatal error resulting in loss of data, you can recover all your changes by importing the 
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LOG file using the Load Recovery Log... command. However, you should first inspect the file. It 
may not be appropriate to import the entire contents of the file. Refer to the CORE On-line Help 
for further details. 

Enterprise Backup/Data Recovery 
In CORE Enterprise, the Enterprise Server seamlessly maintains the CORE data repository as well as 
transaction logs that can be used to recover data in the event of a server machine crash. 

Uninstalling CORE 5.1 
To remove CORE 5.1 from your system, select Add/Remove Programs from the Windows control panel. 
Select CORE Workstation 5.1 or CORE Enterprise Client from the list of applications available to uninstall 
and click the Add/Remove button. Follow the instructions provided by the installer to remove the 
application. 
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Upgrading from CORE Version 4.0 and Earlier 
CORE 5.1 can be installed on the same machine as your existing CORE 4.0 (or earlier) installation in 
order to simplify the upgrade process. You may migrate all projects at one time or on a project-by-project 
basis, depending upon your needs. 

 

P
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Note: While CORE Enterprise Server 5.1 can run in parallel on the same server as previous versions 
of CORE Enterprise server, performance will degrade if both versions of Enterprise are in use. It is 
recommended that the migration period from the old server to the 5.1 server be minimized so that 
machine resources are not divided across multiple Enterprise installations. 
lease read the instructions in this section before beginning the upgrade process. Details on how to 
erform each task may be found in the CORE online help. When exporting files, be sure to use the 
efault names or names that identify the projects from which they were exported. Please refer to the 
ORE 5.0 Data Migration Guide available on the Vitech website in the Documentation area. 

pgrading from Previous Versions of Workstation to 5.1 
 CORE images are not compatible across versions (i.e., you cannot run a CORE 4.0 image file 

using CORE 5.1). Therefore, it is important to locate all image files and migrate the contents to 
CORE 5.1 or archive the data to rdt files. 

 For each project in an image file, the project administrator should perform a full database export 
from those projects to be migrated. 

 
Note: It is important to perform the exports from an account with project administrator permissions to
ensure all elements and attribute values are exported. 
 If schema customizations have been made to any projects in the image, the project administrator 
should also export the schemas from those projects. 

 If custom hierarchy diagram definitions, sort block definitions, or element filters have been added, 
the project administrator should also export them from those projects using the Export Settings 
command. 

 To migrate your CORE users, user settings, and groups from your existing image to CORE 5.1, 
copy all of the .ACF files from the “…\CORE Workstation 40\ACF” directory to your “…\CORE 
Workstation 50\ACF” directory. 

 In CORE 5.1, create an empty project with the same name as each of the projects previously 
exported. Each project should be created with the appropriate 4.0 schema (base or C4ISR) to 
match the project being imported. 

 The project administrator should import all the appropriate files into each new project: schema 
first, if applicable, then database and settings (hierarchy definitions, sort block definitions, and 
element filters), if applicable. 

 Save the image file. 

 Copy any custom user reports to the proper CORE Workstation 5.0 report directory.  By default, 
these files are located in the C:\Program Files\Vitech Corporation\CORE Workstation 
x\Reports\User directory, and should be copied to the C:\Program Files\Vitech Corporation\CORE 
Workstation 50\Reports\40 Reports\User directory. 

 Once the contents of all image files have been migrated or archived, uninstall the previous 
version of CORE. 
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Upgrading from Previous Versions of Enterprise to 5.1 
 If migrating all projects at once, be sure to establish a time after which no further changes may be 

made to your existing CORE Enterprise repository. If migrating a single project, establish a time 
after which no further changes can be made to that project. 

 

 

 

Note: It is important to perform the exports from an account with project administrator permissions to
ensure all elements and attribute values are exported. 
 When it is certain that no users will be making further changes to the existing CORE Enterprise 
repository, the project administrator should perform a full database export from those projects to 
be migrated. 
Warning: The Administrator account has system administration privileges. However, this is not a back 
door to bypass access controls for a given project. Before shutting down your existing Enterprise 
server, contact all users to ensure that any projects to which the Administrator account does not have 
access have been exported from the repository. 
 If schema customizations have been made to any projects in the existing CORE Enterprise 
repository, the project administrator should also export the schemas from those projects to be 
migrated. 

 If custom hierarchy diagram definitions, sort block definitions, or element filters have been added, 
the project administrator should also export them from those projects using the Export Settings 
command. 

 To migrate your CORE users, user settings, and groups from your existing CORE Enterprise 
repository to your 5.1 repository, the CORE administrator should open the 4.0 User Group Tool 
and export users and groups. The User Group Tool will prompt you for a directory in which to 
store a series of files, one for each user and group. 

 Be sure to install CORE Enterprise 5.1 clients on all machines that will be accessing the new 
CORE server. A pervious version of the CORE Enterprise client will not be able to access the 
CORE Enterprise 5.1 server. 

 Once the CORE Enterprise 5.1 server is installed and operational, the CORE administrator 
should log in with a CORE Enterprise 5.1 client and import the users and groups previously 
exported using the Import Users and Groups command on the File menu of the Administrative 
Tools view. 

 In the new CORE Enterprise 5.1 repository, create an empty project with the same name as each 
of the projects previously exported from the existing CORE Enterprise repository. Each project 
should be created with the appropriate 4.0 schema (base or C4ISR) to match the project being 
imported. 

 The project administrator should import all the appropriate files into each new project: schema 
first, if applicable, then database and settings (hierarchy definitions, sort block definitions, and 
element filters), if applicable. 

 Report files are stored with the Enterprise client. To move these reports to CORE 5.1, copy any 
custom user reports to the proper CORE Enterprise Client 5.1 report directory. By default, these 
files are located in the C:\Program Files\Vitech Corporation\CORE Enterprise x 
Client\Reports\User directory, and should be copied to the C:\Program Files\Vitech 
Corporation\CORE Enterprise 50 Client\Reports\40 Reports\User directory. 

 Once all of your projects have been moved from the existing CORE Enterprise server to the 5.1 
server, archive a hot backup of the final state of your existing CORE Enterprise repository, should 
you wish to reinstall it for any reason, and uninstall the existing CORE Enterprise server. 
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Upgrading from CORE 5.0 to 5.1 

 

 

U

U

Important Instructions for Current Users: If you have an existing CORE Enterprise Server/Client or
Workstation 5.0 license but are not under a current maintenance agreement, contact your Account 
Executive to renew your maintenance agreement before installing/upgrading to CORE 5.1. 
pgrading from Workstation 5.0 to 5.1 
 First, make backup copies of your image files (.C50). 

 Workstation 5.0 image files are compatible with Workstation 5.1. Therefore, there is no need to 
export data from 5.0 before running the 5.1 upgrade. 

 There is no need to uninstall Workstation 5.0. Run the Workstation 5.1 installer to upgrade your 
existing 5.0 configuration. 

 Do not run the License Request Utility. Generating a new license request will invalidate your 
existing license file and will disable CORE until the new license file is installed. Follow the 
instructions on page14 in the Licensing section to upgrade your license as appropriate. 

pgrading from Enterprise Server/Client 5.0 to 5.1 
 First, backup your existing Enterprise 5.0 repository on the server. To do this, run a ‘hotbackup’ 

and/or make a backup copy of the “…\CORERepository\extent0.dbf” file on the server. 

 The Enterprise 5.0 repository is compatible with Enterprise 5.1. Therefore, there is no need to 
export data from 5.0 before running the 5.1 upgrade. 

 Upgrade the Enterprise 5.1 Server software only! Run the Enterprise 5.1 Server installer on the 
server machine to upgrade your existing Enterprise 5.0 Server configuration. 

 Do not run the License Request Utility. Generating a new license request will invalidate your 
existing license file and will disable CORE until the new license file is installed. Follow the 
instructions on page14 in the Licensing section to upgrade your license as appropriate. 

 There is no need to install the Enterprise 5.1 Client upgrade on each client machine. As each 
client logs in to the new server, it will automatically download and install the client upgrade. 
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Reporting Problems/Making Product Suggestions 
All customer observations and recommendations are valuable to us. If you should encounter a problem 
with the software (either an error, a deficiency, a feature that works in a manner other than you expected, 
or a problem with any associated documentation), please notify us via e-mail, phone, or fax as indicated 
below. Any information you can provide in your report regarding the hardware and software configuration 
of the host machine, the circumstances in which the problem occurred, conditions to reproduce the 
problem, and such test data as you can reasonably provide to assist Vitech in reproducing the problem 
would be greatly appreciated. 

We hope that you enjoy the new capabilities of CORE 5.1.  

Vitech Corporation 
2070 Chain Bridge Road, Suite 100 

Vienna, VA 22182-2536 
+1 703.883.2270 | Fax: +1 703.883.1860 

support@vitechcorp.com 
http://www.vitechcorp.com 
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